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Introduction

Electric motors are ubiquitous in many different industries. Cars, white goods, heating, 
ventilation, and air conditioning (HVAC) systems require electric motors that not only 
have the right electromechanical characteristics but also limit the noise generated during 
its operation. This model demonstrates how to analyze the noise generated by an electric 
motor during its operation at different speeds of rotation. The type of electric motor 
analyzed, a permanent magnet synchronous motor (PMSM) uses permanent magnets in 
the rotor and a variable frequency current traveling through the stator to generate torque. 

Figure 1: Geometry of the electric motor without the surrounding domains.

The geometry of the electric motor is shown in Figure 1. The internal structure of the 
motor, shown in Figure 2, shows how there is a minimum angle of rotation that brings 
back the geometry to an equivalent of the initial position, based on the number of poles 
and coils.The existence of this minimal mechanical repetition angle, which for this motor 
is 60o, means that electromagnetic forces at any point will be repeated in a cycle that takes 
place six times for each turn of the rotor. The electromagnetic forces generated during its 
operation result in vibrations not only at the frequency of six times the frequency of 
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rotation (of the rotor) but also at higher frequencies. These higher-order frequencies are 
called the harmonics.

A transient analysis is used to determine the electromagnetic forces through a minimal 
mechanical repetition angle (in this case 60°). A Fourier transform is used to determine 
the contributions of each of these harmonics that repeat every 6, 12, 18, … times during 
a complete turn of the rotor. These forces will act at multiples of 6 times the frequency of 
rotation.

The vibroacoustic response of the PMSM casing and its acoustic radiation is computed for 
each of these harmonics. A Campbell diagram is generated showing the main harmonics 
contributing to the acoustic response of the PMSM at various speeds of rotation.

Model Definition

The electromagnetic characteristics of a PMSM are typically well approximated by 
simulating a 2D section of the motor. In order to reduce the computational cost of the 
current analysis, the model uses this approximation and computes the electromagnetic 
forces using a 2D model. The section of the PMSM, shown in Figure 2, is used to compute 
the transient electromagnetic forces developed during its rotation. This transient 
simulation covers a rotation of 60°.
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Figure 2: 2D section the electric motor with the surrounding air domains.

This analysis produces a spatial distribution of forces that are computed through the 
rotation and are transformed in the frequency domain by using the Time to Frequency 
FFT Solver. This solver performs a discrete Fourier transformation of a time-dependent 
variable and transforms it into a series of complex coefficients given by Equation 1

,  (1)

where ω(fk) is the complex Fourier coefficients for the frequency fk, u(tj) is the input 
signal at the time tj, i denotes the imaginary unit and N is the total number of samples of 
the input signal. For each frequency fk, this transformation produces a spatial distribution 
of complex forces. The fact that these forces are complex valued means that the excitation 
includes both the force magnitude and its phase, so different parts of the model will be 
excited at different phases.

The frequency at which these electromagnetic forces are created is directly proportional to 
the speed of rotation of the rotor. As these forces produce an almost constant torque, the 
mechanical power generated by the motor is in fact proportional to the speed of rotation. 
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This is usually true for small rotational speeds. The thermal losses in the coils are 
proportional to the mechanical power of the engine. As the rotational speed increases, 
these losses become substantial and the passive cooling is not able to keep up. This is what 
is called the thermal limit of the motor. Most motors control the torque-speed curve to 
avoid reaching the thermal limit. This curve usually keeps a constant torque for low 
rotational speeds and then a constant power at higher speeds. The model uses the torque-
speed curve shown in Figure 3, but any other curve could be used instead.

Figure 3: Torque-Speed of rotation curve.

The electromagnetic forces generated will follow a cycle that repeats 6 times during a turn 
of the rotor. This cycle will have a main sinusoidal component but also sinusoidal 
components that repeat every 12, 18, 24, … times during a turn of the rotor. These are 
called harmonics. Each of these harmonics will have a different contribution to the total 
noise at various driving frequencies. In the following step, the 2D harmonic forces are 
applied to the 3D model of the electric engine with the acoustic domains surrounding the 
motor. The frequency at which harmonic is applied will be a multiple of the speed of 
rotation of the rotor. Figure 4 shows the 3D geometry including the surrounding acoustic 
domains.
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Figure 4: 3D geometry including the acoustic domains representing an open domain.

Once the frequency response to each of the harmonic excitation is known, it is possible to 
create a Campbell diagram, sometimes called Waterfall plot. The Campbell diagram shows, 
for a given location, the contribution of the different harmonics to the total noise level as 
a function of the rotational speed. This allows the identification of undesirable 
characteristics like frequencies where the casing is very efficient at radiating noise or 
harmonics which are dominant in the total noise.

Another method to present these results is to generate a time signal of the acoustic 
response at a given point as the rotational speed of the motor varies. Figure 5 shows the 
variation of the rotational speed during the duration of the acoustic signal used to generate 
the time signal. Any other duration of the time signal or variation profile of the rotational 
speed could be used.
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Figure 5: Variation of the motor rotational speed during the duration of the acoustic signal.

This model presents a quick and efficient method to analyze the harmonic content of the 
sound generated by a PMSM. Other acoustic sources like the gear noise or the wind 
induced noise due to the refrigeration are not considered. Due to the limited frequency 
content of the harmonic noise, it is usually the noise that stands out in an electric motor 
and thus the main source that is tuned during the design of an electric motor.

Results and Discussion

Figure 6 shows the magnetic flux density norm and streamlines at four different angles. 
Note the rotation of the rotor and how the magnetic flux is concentrated in the areas close 
to the magnets and in the outer part of the coils.
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Figure 6: Magnetic flux density norm and streamlines at four angles through the cycle.

The time-domain analysis produces a distribution of forces in the stator and rotor. As an 
example of the time variation of these forces, Figure 7 shows the components of the 
electromagnetic forces for two points in the model. This time signal is a periodic signal 
that will be repeated 6 times during a complete rotation of the rotor.
8 |  E L E C T R I C  M O T O R  N O I S E :  P E R M A N E N T  M A G N E T  S Y N C H R O N O U S  M O T O R



Figure 7: Time domain signal of the components of the electromagnetic forces at two points.

This time signal can be easily transformed into the frequency domain and normalized to 
the value of the first harmonic. Figure 8 shows how the FFT of the forces normalized to 
the first harmonic, has decreasing values as the frequency increases. The eighth harmonic 
has a contribution that is below 5% of the first harmonic, so considering seven harmonics 
in the analysis seems reasonable, as any higher order harmonics are likely to have very 
limited influence.
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Figure 8: Frequency domain components of the electromagnetic forces at two points, 
normalized to the first harmonic value.

It is also relevant to analyze the spatial distribution of the different harmonics, not only its 
variation with frequency for a single point. Figure 9 shows the spatial distribution of the 
seventh harmonic, the last harmonic solved for. Harmonics above this one will require a 
finer mesh, as the higher the harmonic, the finer the spatial distribution of the 
electromagnetic forces. In order to solve harmonics above the seventh, the model would 
need to have a finer mesh, which would increase the computational time and will not add 
substantial contributions to the noise.
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Figure 9: Spatial distribution of the electromagnetic forces in the frequency domain, showing 
both real (red arrows) and imaginary (blue arrows) parts.

The electromagnetic forces obtained in the 2D model can be translated to the 3D model 
using the General Extrusion feature. Figure 10 shows the 3D model and the forces 
generated by the third harmonic.
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Figure 10: Real part of the electromagnetic forces applied to the 3D model for the third 
harmonic.

This forces, although compensated globally due to the symmetry of the motor, produce 
displacements in the structure that in turn are converted to acoustic pressure. 
Figure 11shows the displacement and acoustic pressure generated by the third harmonic 
at 2360 Hz.
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Figure 11: Displacements and acoustic pressures generated by the third harmonic at 2360 Hz.

The Exterior Field feature permits the evaluation of the acoustic pressure at any point 
outside of the computational domain. Figure 12 shows the sound pressure level (SPL) at 
the surface of the motor and at 0.5 m away from the motor. Note how this radiation 
pattern has many lobes, meaning that the acoustic response will depend greatly on the 
position of the listening point.
13 |  E L E C T R I C  M O T O R  N O I S E :  P E R M A N E N T  M A G N E T  S Y N C H R O N O U S  M O T O R



Figure 12: Sound pressure level at the surface of the motor and 0.5 m away.

The contribution of the different harmonics can be seen in a Campbell diagram. A 
Campbell diagram shows, for a given listening point, the sound pressure level of each 
harmonic as a function of the speed of rotation of the motor. Figure 13 shows how the 
two microphones present very different Campbell diagrams. Note how the first and third 
harmonics have the largest influence on the noise level for both microphone positions. 
Note as well how the first microphone shows increased noise levels around 2500 Hz for 
most of the harmonics, indicating that there is a casing mode making this frequency stand 
out. A similar effect is found for the second microphone slightly below 2500 Hz and 
around 1800 Hz.
14 |  E L E C T R I C  M O T O R  N O I S E :  P E R M A N E N T  M A G N E T  S Y N C H R O N O U S  M O T O R



Figure 13: Campbell diagrams at the microphones.
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Notes About the COMSOL Implementation 

The electromagnetic model contains two different objects forming an assembly. Having 
independent meshes in each of the objects permits the rotation of the rotor using the 
Rotating Domain feature.

The electromagnetic analysis study composes two steps, a stationary analysis and a time-
dependent analysis. The stationary analysis is used to initialize the electromagnetic field as 
the system contains permanent magnets and nonzero currents at the initial time. Trying 
to solve the time-dependent analysis without the stationary part assumes that the currents 
are switched on and the magnets added at the first time step. This will make reaching 
convergence almost impossible. Turning the Jacobian update to every iteration for the 
time-dependent analysis reduces the total running time.

The electromagnetic forces are computed through the use of the Force Calculation 
feature available in the Magnetic Fields interface. A Weak Form Boundary PDE is used to 
store the electromagnetic forces at the interfaces and produce an FFT only of these forces 
instead of the complete solution.

The Time to Frequency FFT study is used to transform a spatial and time-dependent 
variable into a complex variable in the frequency domain. Once that the electromagnetic 
forces are expressed in the frequency domain, it is simpler to produce frequency response 
analysis for a varying excitation.

The General Extrusion feature is used to transform variables existing in a component to 
another component with different coordinates or even different number of dimensions. In 
this case, the 2D results are translated to the 3D component using the comp.genext() 
operator.

The withsol() operator is used to select the right harmonic of the excitation forces in the 
frequency sweep. As an example, the expression, withsol("sol3",Fy,setval(freq,
f0*(harm_exc))), takes the variable Fy from the sol3 (The results of the FFT) with the 
frequency matching f0 (the speed of rotation of the rotor in the initial transient analysis) 
times the number of the harmonic excited.

The frequency request in the vibroacoustic analysis uses the expression range(360[deg]/
theta*rpm_idle*harm_exc,fdelta,min(fmax,rpm_max/rpm0*f0*harm_exc)) 

min(fmax,rpm_max/rpm0*f0*harm_exc), which is a frequency sweep starting at six 
times rpm_idle times the number of the harmonic excited, taking steps every fdelta and 
stopping when the rotational speed reaches rpm_max or the frequency reaches fmax, 
whatever happens first.
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The solver in the vibroacoustic analysis is manually set to a segregated solver with 1 
iteration, meaning that the displacements will be obtained first and the acoustic pressure 
will be computed based on these displacements, without backcoupling of the acoustic 
pressure into the structural problem. This is an adequate approach for problems where 
vibrating structures radiate noise into the environment, and it allows for a reduction in the 
running times. This assumption should always be confirmed with a fully coupled analysis.

The model takes approximately 8 hours to run on a workstation with a sweep of seven 
harmonics and outputs every 50 Hz. This runtime can be significantly reduced by using 
distributed cluster computation or reducing the number of frequencies or harmonics 
requested.

The acoustic signal is exported to a .wav file that could be listened to or postprocessed with 
any other tool.

Application Library path: Acoustics_Module/Automotive/
electric_motor_noise_pmsm

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select AC/DC > Electromagnetic Fields > Magnetic Fields (mf).

3 Click Add.

4 In the Select Physics tree, select Mathematics > PDE Interfaces > Lower Dimensions > 
Weak Form Boundary PDE (wb).

5 Click Add.

6 Click Study.

7 In the Select Study tree, select General Studies > Stationary.

8 Click Done.
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R O O T

The first study uses the cross section of the electric motor to compute the electromagnetic 
excitation. Proceed to add a 3D component and import the geometry of the motor.

A D D  C O M P O N E N T

In the Home toolbar, click Add Component and choose 3D.

G E O M E T R Y  2

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
electric_motor_noise_pmsm_geom_sequence.mph.

3 In the Geometry toolbar, click Build All.

4 Click the Zoom Extents button in the Graphics toolbar.

5 Click the Wireframe Rendering button in the Graphics toolbar.

6 Click the Show Grid button in the Graphics toolbar.

Wireframe rendering allows for an easier visualization of the geometry. The geometry 
should look like Figure 4.

Form Assembly (fin)
1 In the Model Builder window, under Component 2 (comp2) > Geometry 2 click 

Form Assembly (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 Clear the Create pairs checkbox.

The imported COMSOL file includes a set of parameters which facilitate the update of the 
electric motor. Update the name of the parameter group.

G L O B A L  D E F I N I T I O N S

Geometry parameters
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry parameters in the Label text 
field.

Add a new parameter group and populate this group with the parameters imported from 
an external file. This second parameter group includes parameter related to the modeling.

Model Parameters
1 In the Home toolbar, click Parameters and choose Add > Parameters.
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2 In the Settings window for Parameters, type Model Parameters in the Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
electric_motor_noise_pmsm_parameters.txt.

Add a Cross Section feature to generate the 2D geometry. As the rotor will be rotating 
through a Rotating Domain feature, it is necessary that the 2D geometry is created as an 
assembly.

G E O M E T R Y  1

In the Model Builder window, under Component 1 (comp1) click Geometry 1.

Cross Section 1 (cro1)
1 In the Geometry toolbar, click Cross Section.

2 In the Settings window for Cross Section, click Build Selected.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 click 

Form Union (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 From the Action list, choose Form an assembly.

4 In the Geometry toolbar, click Build All.

The geometry should look like Figure 2.

Now proceed to create some selections that will be used during the model definition.

D E F I N I T I O N S  ( C O M P 1 )

Shaft
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Shaft in the Label text field.

3 Select Domain 40 only.

Laminated rotor
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Laminated rotor in the Label text field.

3 Select Domain 39 only.
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Magnets A
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Magnets A in the Label text field.

3 Select Domains 33, 37, and 39 only.

Magnets B
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Magnets B in the Label text field.

3 Select Domains 34, 36, and 40 only.

Magnets
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Magnets in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Magnets A and Magnets B.

5 Click OK.

Inner air gap
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Inner air gap in the Label text field.

3 Select Domain 32 only.

Rotor
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Rotor in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Shaft, Laminated rotor, and 
Magnets.

5 Click OK.

Rotating parts
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Rotating parts in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Inner air gap and Rotor.

5 Click OK.
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Fixed Parts
1 In the Definitions toolbar, click Complement.

2 In the Settings window for Complement, type Fixed Parts in the Label text field.

3 Locate the Input Entities section. Under Selections to invert, click Add.

4 In the Add dialog, select Rotating parts in the Selections to invert list.

5 Click OK.

Coils A
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Coils A in the Label text field.

3 Select Domains 12, 15, 18, 20, 25, and 27 only.

Coils B
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Coils B in the Label text field.

3 Select Domains 13, 16, 17, 19, 26, and 28 only.

Coils C
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Coils C in the Label text field.

3 Select Domains 9, 10, and 21–24 only.

Coils
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Coils in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Coils A, Coils B, and Coils C.

5 Click OK.

Outer air gap
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Outer air gap in the Label text field.

3 Select Domain 11 only.

Exterior air
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Exterior air in the Label text field.
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3 Select Domains 1–4, 14, 30, and 31 only.

Casing
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Casing in the Label text field.

3 Select Domains 5–7 and 29 only.

Air
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Air in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Inner air gap, Outer air gap, and 
Exterior air.

5 Click OK.

Stator forces
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Stator forces in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, select Fixed Parts in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog, in the Selections to subtract list, choose Coils, Casing, and Air.

9 Click OK.

External boundaries
1 In the Model Builder window, right-click Selections and choose Disk.

2 In the Settings window for Disk, type External boundaries in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Size and Shape section. In the Outer radius text field, type inf.

5 In the Inner radius text field, type r_stator.

Adjacent to rotor forces
1 In the Definitions toolbar, click Adjacent.
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2 In the Settings window for Adjacent, type Adjacent to rotor forces in the Label text 
field.

3 Locate the Input Entities section. Under Input selections, click Add.

4 In the Add dialog, select Rotor in the Input selections list.

5 Click OK.

Adjacent to stator forces
1 In the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, type Adjacent to stator forces in the Label 
text field.

3 Locate the Input Entities section. Under Input selections, click Add.

4 In the Add dialog, select Stator forces in the Input selections list.

5 Click OK.

Force calculation
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Force calculation in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Adjacent to rotor forces and 
Adjacent to stator forces.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, select External boundaries in the Selections to subtract list.

10 Click OK.

Adjacent to air gaps and coils
1 In the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, type Adjacent to air gaps and coils in the 
Label text field.

3 Locate the Input Entities section. Under Input selections, click Add.

4 In the Add dialog, in the Input selections list, choose Inner air gap, Coils, and 
Outer air gap.

5 Click OK.
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Iron
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Iron in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Shaft, Laminated rotor, and 
Stator forces.

5 Click OK.

Force calculation domains
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Force calculation domains in the Label text 
field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Inner air gap, Coils, and 
Outer air gap.

5 Click OK.

Adjacent to air gap in the stator
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Adjacent to air gap in the stator in 
the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Adjacent to stator forces in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, select External boundaries in the Selections to subtract list.

10 Click OK.

Add a variable that will define the rotation both in a stationary and a time dependent step.

Variables 1
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, locate the Variables section.
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3 In the table, enter the following settings:

The General Extrusion coupling operator to map the 2D results into the 3D geometry. This 
operator allows to map geometries even when the coordinate axes are not aligned.

General Extrusion 1 (genext1)
1 In the Definitions toolbar, click Nonlocal Couplings and choose General Extrusion.

2 In the Settings window for General Extrusion, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Force calculation.

5 Locate the Destination Map section. In the x-expression text field, type y.

6 In the y-expression text field, type z.

7 Locate the Source section. Select the Use source map checkbox.

8 Click to expand the Advanced section. From the Mesh search method list, choose 
Closest point.

9 Select the Use NaN when mapping fails checkbox.

Add a Cylindrical System that will be used to define the orientation of the magnets.

Cylindrical System 3 (sys3)
In the Definitions toolbar, click Coordinate Systems and choose Cylindrical System.

The Rotating Domain allows for the rotor to move independently of the stator.

C O M P O N E N T  1  ( C O M P 1 )

Rotating Domain 1
1 In the Physics toolbar, click Moving Mesh and choose Rotating Domain.

2 In the Settings window for Rotating Domain, locate the Domain Selection section.

3 From the Selection list, choose Rotating parts.

4 Locate the Rotation section. In the α text field, type rotation.

In the next steps, add the materials that make the section of the motor.

A D D  M A T E R I A L

1 In the Materials toolbar, click Add Material to open the Add Material window.

Name Expression Unit Description

rotation if(isdefined(t),w0*t+ang0,0) rad Rotation
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2 Go to the Add Material window.

3 In the tree, select AC/DC > Soft Iron (Without Losses).

4 Click the Add to Component button in the window toolbar.

M A T E R I A L S

Soft Iron (Without Losses) (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Iron.

Add a relative permeability of 1 to the material.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select AC/DC > Copper.

3 Click the Add to Component button in the window toolbar.

M A T E R I A L S

Copper (mat2)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Coils.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select AC/DC > Hard Magnetic Materials > 
Sintered NdFeB Grades (Chinese Standard) > N40 (Sintered NdFeB).

3 Click the Add to Component button in the window toolbar.

4 In the tree, select Built-in > Aluminum 6063-T83.

5 Click the Add to Component button in the window toolbar.

6 In the Materials toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

N40 (Sintered NdFeB) (mat3)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Magnets.
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Aluminum 6063-T83 (mat4)
1 In the Model Builder window, click Aluminum 6063-T83 (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Casing.

M A G N E T I C  F I E L D S  ( M F )

Specify the length of the motor.

1 In the Model Builder window, under Component 1 (comp1) click Magnetic Fields (mf).

2 In the Settings window for Magnetic Fields, locate the Thickness section.

3 In the d text field, type Ltransv.

Use linear discretization and solve only in magnetically relevant regions to increase 
robustness of the solver.

4 Click to expand the Discretization section. From the Magnetic vector potential list, 
choose Linear.

5 Select Domains 8–13, 15–28, and 32–40 only.

Iron Domains
1 In the Physics toolbar, click Domains and choose Ampère’s Law in Solids.

2 In the Settings window for Ampère’s Law in Solids, type Iron Domains in the Label text 
field.

3 Locate the Domain Selection section. From the Selection list, choose Iron.

4 Locate the Constitutive Relation B-H section. From the Magnetization model list, choose 
B-H curve.

Magnets A
1 In the Physics toolbar, click Domains and choose Ampère’s Law in Solids.

2 In the Settings window for Ampère’s Law in Solids, type Magnets A in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Magnets A.

The magnets are oriented along the tangent direction of the rotor.

4 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Cylindrical System 3 (sys3).

5 Locate the Constitutive Relation B-H section. From the Magnetization model list, choose 
Remanent flux density.

6 Locate the Constitutive Relation Jc-E section. From the σ list, choose User defined.
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Magnets B
1 Right-click Magnets A and choose Duplicate.

2 In the Settings window for Ampère’s Law in Solids, type Magnets B in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Magnets B.

4 Locate the Constitutive Relation B-H section. Specify the e vector as

Proceed to define the motor coil groups.

Coils A
1 In the Physics toolbar, click Domains and choose Domain Coil.

2 In the Settings window for Domain Coil, type Coils A in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Coils A.

4 Locate the Material Type section. From the Material type list, choose Solid.

5 Locate the Coil section. From the Conductor model list, choose Homogenized multiturn.

6 Select the Coil group checkbox.

7 In the Icoil text field, type I0*cos(3*rotation).

8 Locate the Homogenized Conductor section. In the N text field, type Ncoil.

9 From the list, choose User defined.

10 Find the High-frequency effective loss subsection. Clear the Include harmonic loss 
checkbox.

11 In the a text field, type a_coil.

Add a Reversed Current Direction feature to represent the part of the coil with current 
traveling in the opposing direction.

Reversed Current Direction 1
1 In the Physics toolbar, click Attributes and choose Reversed Current Direction.

2 Select Domains 15, 18, and 27 only.

Coils B
1 In the Model Builder window, right-click Coils A and choose Duplicate.

2 In the Settings window for Domain Coil, type Coils B in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Coils B.

-1 r

0 phi

0 a
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4 Locate the Coil section. In the Icoil text field, type I0*cos(3*rotation-120[deg]).

Reversed Current Direction 1
1 In the Model Builder window, expand the Coils B node, then click 

Reversed Current Direction 1.

2 In the Settings window for Reversed Current Direction, locate the Domain Selection 
section.

3 Click Clear Selection.

4 Select Domains 13, 19, and 26 only.

Coils C
1 In the Model Builder window, right-click Coils B and choose Duplicate.

2 In the Settings window for Domain Coil, type Coils C in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Coils C.

4 Locate the Coil section. In the Icoil text field, type I0*cos(3*rotation-240[deg]).

Reversed Current Direction 1
1 In the Model Builder window, expand the Coils C node, then click 

Reversed Current Direction 1.

2 In the Settings window for Reversed Current Direction, locate the Domain Selection 
section.

3 Click Clear Selection.

4 Select Domains 9, 22, and 23 only.

Add a Continuity feature to make sure that the electromagnetic fields are continuous 
through the identity pair.

Magnetic Continuity 1
1 In the Physics toolbar, click Pairs and choose Magnetic Continuity.

2 In the Settings window for Magnetic Continuity, locate the Pair Selection section.

3 Click Add.

4 In the Add dialog, select Identity Boundary Pair 2 (ap2) in the Pairs list.

5 Click OK.

Enable Weak constraints to improve the accuracy of the magnetic field crossing the 
Continuity.

6 Click the Show More Options button in the Model Builder toolbar.
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7 In the Show More Options dialog, in the tree, select the checkbox for the node Physics > 
Advanced Physics Options.

8 Click OK.

9 In the Settings window for Magnetic Continuity, click to expand the Constraint Settings 
section.

10 From the Constraint list, choose Weak constraints.

Add a Force Calculation feature to define the force and torque variables from the rotor and 
stator.

Force Calculation Rotor
1 In the Physics toolbar, click Domains and choose Force Calculation.

2 In the Settings window for Force Calculation, type Force Calculation Rotor in the 
Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Rotor.

4 Locate the Force Calculation section. In the Force name text field, type rot.

Force Calculation Stator
1 Right-click Force Calculation Rotor and choose Duplicate.

2 In the Settings window for Force Calculation, type Force Calculation Stator in the 
Label text field.

3 Locate the Domain Selection section. From the Selection list, choose Stator forces.

4 Locate the Force Calculation section. In the Force name text field, type stat.

The Weak Form Boundary PDE physics is used for the single purpose of limiting the output 
of the model. The forces at the boundaries will be stored from the time dependent analysis 
and transformed into the frequency domain through a Time to Frequency FFT study step.

W E A K  F O R M  B O U N D A R Y  P D E  ( W B )

1 In the Model Builder window, under Component 1 (comp1) click 
Weak Form Boundary PDE (wb).

2 In the Settings window for Weak Form Boundary PDE, locate the Boundary Selection 
section.

3 From the Selection list, choose Force calculation.

4 Click to expand the Discretization section. From the Element order list, choose Linear.

5 Click to expand the Dependent Variables section. In the Number of dependent variables 
text field, type 2.
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6 In the Dependent variables (1) table, enter the following settings:

7 Locate the Units section. Click Define Dependent Variable Unit.

8 In the Dependent variable quantity table, enter the following settings:

9 Click Define Source Term Unit.

10 In the Source term quantity table, enter the following settings:

Fx and Fy take their values from the electromagnetic forces computed through the Force 

Calculation feature. As the rotor is rotating, some coordinate transformation is required.

Initial Values 1
1 In the Model Builder window, under Component 1 (comp1) > 

Weak Form Boundary PDE (wb) click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the Fx text field, type if(isnan(mf.nTx_stat),mf.nTx_rot*cos(rotation)+
mf.nTy_rot*sin(rotation),mf.nTx_stat).

4 In the Fy text field, type if(isnan(mf.nTy_stat),-mf.nTx_rot*sin(rotation)+
mf.nTy_rot*cos(rotation),mf.nTy_stat).

Now proceed to mesh the Component 1.

M E S H  1

Free Triangular 1
In the Mesh toolbar, click Free Triangular.

Size
1 In the Model Builder window, click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

Fx

Fy

Dependent variable quantity Unit

Custom unit N/m^2

Source term quantity Unit

Custom unit N/m^2
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4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
4[mm].

5 In the Minimum element size text field, type 1[mm].

6 In the Maximum element growth rate text field, type 1.15.

7 In the Curvature factor text field, type 0.1.

Size 1
1 In the Model Builder window, right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Force calculation.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section.

7 Select the Maximum element size checkbox. In the associated text field, type 0.3[mm].

8 Select the Minimum element size checkbox. In the associated text field, type 0.15[mm].

9 Select the Maximum element growth rate checkbox. In the associated text field, type 
1.05.

10 Select the Curvature factor checkbox. In the associated text field, type 0.05.

11 Click Build All.

Add a Boundary Layer feature to make the force calculation more precise.

Boundary Layers 1
1 In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, click to expand the Transition section.

3 Clear the Smooth transition to interior mesh checkbox.

Boundary Layer Properties
1 In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection 
section.

3 From the Selection list, choose Force calculation.

4 Locate the Layers section. In the Number of layers text field, type 1.

5 Click Build All.

The image should look like this.
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6 In the Model Builder window, click Mesh 1.

S T U D Y  1

Step 2: Time Dependent
1 In the Study toolbar, click Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type range(0,1/12/n_harmonics,1)*t_tot.

4 Locate the Physics and Variables Selection section. In the Solve for column of the table, 
under Component 1 (comp1), clear the checkbox for Weak Form Boundary PDE (wb).

5 Click to expand the Values of Dependent Variables section. Find the 
Initial values of variables solved for subsection. From the Settings list, choose 
User controlled.

6 From the Method list, choose Solution.

7 From the Study list, choose Study 1, Stationary.

8 Click to expand the Mesh Selection section. There is no need to use the mesh coming 
from the second component.
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9 In the table, enter the following settings:

Step 1: Stationary
1 In the Model Builder window, click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the Solve for column of the table, under Component 1 (comp1), clear the checkbox for 
Weak Form Boundary PDE (wb).

4 Click to expand the Mesh Selection section. There is no need to use the mesh coming 
from the second component.

5 In the table, enter the following settings:

Change the solver options by showing the default solver.

6 In the Model Builder window, click Study 1.

7 In the Settings window for Study, type Study 1 - Electromagnetic Analysis in the 
Label text field.

Solution 1 (sol1)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

3 In the Model Builder window, expand the Study 1 - Electromagnetic Analysis > 
Solver Configurations > Solution 1 (sol1) > Time-Dependent Solver 1 node, then click 
Fully Coupled 1.

4 In the Settings window for Fully Coupled, click to expand the Method and Termination 
section.

5 From the Jacobian update list, choose On every iteration.

Turning the Jacobian update to every iteration will reduce the running time.

6 In the Study toolbar, click Compute.

R E S U L T S

Magnetic Flux Density (mf)
The following steps guide you through the postprocess of the model.

Component Mesh

Component 2 No mesh

Component Mesh

Component 2 No mesh
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Study 1 - Electromagnetic Analysis/Solution 1 (sol1)
In the Model Builder window, expand the Results > Datasets node.

Surface 1
1 In the Model Builder window, expand the Results > Magnetic Flux Density (mf) node, then 

click Surface 1.

2 In the Settings window for Surface, click to expand the Range section.

3 Select the Manual color range checkbox.

4 In the Minimum text field, type 0.

5 In the Maximum text field, type 1.5.

Magnetic Flux Density (mf)
1 In the Model Builder window, click Magnetic Flux Density (mf).

2 In the Settings window for 2D Plot Group, click to expand the Title section.

3 From the Title type list, choose Label.

4 Locate the Color Legend section. Clear the Show legends checkbox.

Arrow Line 1
1 Right-click Magnetic Flux Density (mf) and choose Arrow Line.

2 In the Settings window for Arrow Line, locate the Expression section.

3 In the x-component text field, type mf.nTx_stat.

4 In the y-component text field, type mf.nTy_stat.

5 Locate the Arrow Positioning section. From the Placement list, choose Gauss points.

6 In the Magnetic Flux Density (mf) toolbar, click Plot.

Arrow Line 2
1 Right-click Magnetic Flux Density (mf) and choose Arrow Line.

2 In the Settings window for Arrow Line, locate the Expression section.

3 In the x-component text field, type mf.nTx_rot.

4 In the y-component text field, type mf.nTy_rot.

5 Locate the Arrow Positioning section. From the Placement list, choose Gauss points.

6 Click to expand the Title section. From the Title type list, choose None.

7 Locate the Coloring and Style section. From the Color list, choose Blue.

8 In the Magnetic Flux Density (mf) toolbar, click Plot.

Loop through the different frequencies to reproduce the plots in Figure 6.
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Electromagnetic Forces in Selected Points, Time Domain
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Electromagnetic Forces in 
Selected Points, Time Domain in the Label text field.

3 Locate the Plot Settings section.

4 Select the y-axis label checkbox. In the associated text field, type Stress (MPa).

5 Click to expand the Title section. From the Title type list, choose Label.

Point Graph 1
1 Right-click Electromagnetic Forces in Selected Points, Time Domain and choose 

Point Graph.

2 Select Point 174 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type abs(mf.nTx_stat).

5 From the Unit list, choose MPa.

6 Select the Description checkbox. In the associated text field, type Absolute x stress.

7 Click to expand the Legends section. Select the Show legends checkbox.

8 Find the Include subsection. Select the Description checkbox.

9 Click to expand the Coloring and Style section. Find the Line markers subsection. From 
the Marker list, choose Point.

10 In the Electromagnetic Forces in Selected Points, Time Domain toolbar, click Plot.

Point Graph 2
1 Right-click Point Graph 1 and choose Duplicate.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTy_stat).

4 In the Description text field, type Absolute y stress.

Point Graph 3
1 Right-click Point Graph 2 and choose Duplicate.

2 In the Settings window for Point Graph, locate the Selection section.

3 Click Clear Selection.

4 Select Point 176 only.

5 Locate the y-Axis Data section. In the Expression text field, type abs(mf.nTx_stat).

6 In the Description text field, type Absolute x stress.
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Point Graph 4
1 Right-click Point Graph 3 and choose Duplicate.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTy_stat).

4 In the Description text field, type Absolute y stress.

5 In the Electromagnetic Forces in Selected Points, Time Domain toolbar, click Plot.

The image should look like Figure 7.

Electromagnetic Forces in Selected Points, FFT
1 In the Model Builder window, right-click Electromagnetic Forces in Selected Points,

Time Domain and choose Duplicate.

2 In the Model Builder window, click Electromagnetic Forces in Selected Points,

Time Domain 1.

3 In the Settings window for 1D Plot Group, type Electromagnetic Forces in 
Selected Points, FFT in the Label text field.

4 Locate the Plot Settings section.

5 Select the x-axis label checkbox. In the associated text field, type Frequency (Hz).

6 In the y-axis label text field, type Fourier Coefficient (MPa).

Point Graph 1
1 In the Model Builder window, click Point Graph 1.

2 In the Settings window for Point Graph, locate the x-Axis Data section.

3 From the Parameter list, choose Discrete Fourier transform.

4 From the Show list, choose Frequency spectrum.

5 Select the Frequency range checkbox.

6 In the Minimum text field, type f0/2.

7 In the Maximum text field, type f0*(n_harmonics+1).

Point Graph 2
1 In the Model Builder window, click Point Graph 2.

2 In the Settings window for Point Graph, locate the x-Axis Data section.

3 From the Parameter list, choose Discrete Fourier transform.

4 From the Show list, choose Frequency spectrum.

5 Select the Frequency range checkbox.

6 In the Minimum text field, type f0/2.
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7 In the Maximum text field, type f0*(n_harmonics+1).

Point Graph 3
1 In the Model Builder window, click Point Graph 3.

2 In the Settings window for Point Graph, locate the x-Axis Data section.

3 From the Parameter list, choose Discrete Fourier transform.

4 From the Show list, choose Frequency spectrum.

5 Select the Frequency range checkbox.

6 In the Minimum text field, type f0/2.

7 In the Maximum text field, type f0*(n_harmonics+1).

Point Graph 4
1 In the Model Builder window, click Point Graph 4.

2 In the Settings window for Point Graph, locate the x-Axis Data section.

3 From the Parameter list, choose Discrete Fourier transform.

4 From the Show list, choose Frequency spectrum.

5 Select the Frequency range checkbox.

6 In the Minimum text field, type f0/2.

7 In the Maximum text field, type f0*(n_harmonics+1).

8 Click the y-Axis Log Scale button in the Graphics toolbar.
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9 In the Electromagnetic Forces in Selected Points, FFT toolbar, click Plot.

The image should look like this.

Electromagnetic Forces in Selected Points, FFT , Normalized to First Harmonic
1 In the Model Builder window, right-click Electromagnetic Forces in Selected Points, FFT 

and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Electromagnetic Forces in 
Selected Points, FFT , Normalized to First Harmonic in the Label text field.

3 Locate the Plot Settings section. In the y-axis label text field, type Normalized Fourier 
Coefficient (1).

4 Locate the Legend section. From the Position list, choose Lower left.

Now proceed to normalize the values using the first harmonic coefficient.

Point Graph 1
1 In the Model Builder window, expand the Electromagnetic Forces in Selected Points, FFT ,

Normalized to First Harmonic node, then click Point Graph 1.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTx_stat)/5.4675[MPa].
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4 In the Description text field, type Absolute x stress normalized to first 
harmonic.

Point Graph 2
1 In the Model Builder window, click Point Graph 2.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTy_stat)/0.330696[MPa].

4 In the Description text field, type Absolute y stress normalized to first 
harmonic.

Point Graph 3
1 In the Model Builder window, click Point Graph 3.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTx_stat)/0.079339[MPa].

4 In the Description text field, type Absolute x stress normalized to first 
harmonic.

Point Graph 4
1 In the Model Builder window, click Point Graph 4.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(mf.nTy_stat)/6.187[MPa].

4 In the Description text field, type Absolute y stress normalized to first 
harmonic.

5 In the Electromagnetic Forces in Selected Points, FFT , Normalized to First Harmonic 
toolbar, click Plot.

The image should look like Figure 8.

Create a new study to transform the electromagnetic forces to the frequency domain.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.
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S T U D Y  2  -  E L E C T R O M A G N E T I C  F O R C E S  F F T

In the Settings window for Study, type Study 2 - Electromagnetic Forces FFT in the 
Label text field.

Step 1: Time to Frequency FFT
1 In the Study toolbar, click More Study Steps and choose Frequency Domain > 

Time to Frequency FFT.

2 In the Settings window for Time to Frequency FFT, locate the Study Settings section.

3 From the Prescribed by list, choose Initial expression.

4 From the Input study list, choose Study 1 - Electromagnetic Analysis, Time Dependent.

5 In the End time text field, type t_tot.

6 In the Maximum output frequency text field, type n_harmonics/t_tot.

7 Locate the Physics and Variables Selection section. In the Solve for column of the table, 
under Component 1 (comp1), clear the checkbox for Magnetic Fields (mf).

8 In the Study toolbar, click Compute.

R E S U L T S

Electromagnetic Forces, FFT
1 In the Settings window for 2D Plot Group, type Electromagnetic Forces, FFT in the 

Label text field.

2 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

Line 1
1 In the Model Builder window, expand the Electromagnetic Forces, FFT node, then click 

Line 1.

2 In the Settings window for Line, click to expand the Title section.

3 From the Title type list, choose None.

4 Locate the Coloring and Style section. From the Line type list, choose Tube.

5 In the Tube radius expression text field, type 0.0002.

6 Select the Radius scale factor checkbox.

7 From the Coloring list, choose Uniform.

8 From the Color list, choose Black.

Arrow Line 1
1 In the Model Builder window, right-click Electromagnetic Forces, FFT and choose 

Arrow Line.
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2 In the Settings window for Arrow Line, locate the Expression section.

3 In the x-component text field, type real(Fx)/t_tot.

4 In the y-component text field, type real(Fy)/t_tot.

5 Select the Description checkbox. In the associated text field, type Real Force 
Components (Red).

6 Locate the Arrow Positioning section. From the Placement list, choose Gauss points.

7 In the Electromagnetic Forces, FFT toolbar, click Plot.

Arrow Line 2
1 Right-click Electromagnetic Forces, FFT and choose Arrow Line.

2 In the Settings window for Arrow Line, locate the Expression section.

3 In the x-component text field, type imag(Fx)/t_tot.

4 In the y-component text field, type imag(Fy)/t_tot.

5 Select the Description checkbox. In the associated text field, type Imaginary Force 
Components (Blue).

6 Locate the Arrow Positioning section. From the Placement list, choose Gauss points.

7 Locate the Coloring and Style section. From the Color list, choose Blue.

8 In the Electromagnetic Forces, FFT toolbar, click Plot.

The image should look like Figure 9.

Electromagnetic Forces in Selected Points, FFT, Electromagnetic Forces in Selected 
Points, FFT , Normalized to First Harmonic, Electromagnetic Forces in Selected Points, 
Time Domain, Electromagnetic Forces, FFT, Magnetic Flux Density (mf)
1 In the Model Builder window, under Results, Ctrl-click to select 

Magnetic Flux Density (mf), Electromagnetic Forces in Selected Points, Time Domain, 
Electromagnetic Forces in Selected Points, FFT, Electromagnetic Forces in Selected Points,

FFT , Normalized to First Harmonic, and Electromagnetic Forces, FFT.

2 Right-click and choose Group.

Electromagnetic Results
In the Settings window for Group, type Electromagnetic Results in the Label text field.

C O M P O N E N T  2  ( C O M P 2 )

Add the physics used in the Component 2.

1 In the Model Builder window, click Component 2 (comp2).
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A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve checkboxes 
for Study 1 - Electromagnetic Analysis and Study 2 - Electromagnetic Forces FFT.

4 In the tree, select Acoustics > Acoustic–Structure Interaction > Acoustic–Solid Interaction,

Frequency Domain.

5 Click the Add to Component 2 button in the window toolbar.

6 In the Home toolbar, click Add Physics to close the Add Physics window.

P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  ( A C P R )

1 In the Settings window for Pressure Acoustics, Frequency Domain, locate the 
Domain Selection section.

2 From the Selection list, choose Air.

Add the Exterior Field Calculation feature to obtain the acoustic field in any distant point.

Exterior Field Calculation 1
1 In the Physics toolbar, click Boundaries and choose Exterior Field Calculation.

2 In the Settings window for Exterior Field Calculation, locate the Boundary Selection 
section.

3 From the Selection list, choose Exterior Field Calculation.

4 Locate the Exterior Field Calculation section. From the Condition in the z = z0 plane list, 
choose Symmetric/Infinite sound hard boundary.

5 In the z0 text field, type -0.073.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 2 (comp2) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the Domain Selection section.

3 From the Selection list, choose Structure.

Fixed Constraint 1
1 In the Physics toolbar, click Boundaries and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Fixed Boundaries.
43 |  E L E C T R I C  M O T O R  N O I S E :  P E R M A N E N T  M A G N E T  S Y N C H R O N O U S  M O T O R



Linear Elastic Material 1
In the Model Builder window, click Linear Elastic Material 1.

Damping 1
1 In the Physics toolbar, click Attributes and choose Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

3 From the Input parameters list, choose Damping ratios.

4 In the f1 text field, type f0.

5 In the ζ1 text field, type eta_struct.

6 In the f2 text field, type fmax.

7 In the ζ2 text field, type eta_struct.

Use the Boundary Load feature to apply the electromagnetic loads coming from the 
previous steps. Through the use of the withsol operator, the loads will be taken from the 
different harmonics of Study 2 and applied to the current physics through a parametric 
sweep.

Boundary Load 1
1 In the Physics toolbar, click Boundaries and choose Boundary Load.

2 In the Settings window for Boundary Load, locate the Boundary Selection section.

3 From the Selection list, choose Loaded Boundaries.

In these expressions, tor(rpm) is the torque-speed normalized curve, comp1.genext1 
is the operator that brings variables existing in the Component 1 to Component 2.

4 Locate the Force section. Specify the fA vector as

In the following steps, create a mesh that will minimize the running time while 
maintaining the accuracy.

M E S H  2

Free Triangular 1
1 In the Mesh toolbar, click More Generators and choose Free Triangular.

Start by meshing a section of the motor.

0 x

tor(rpm)*comp1.genext1(withsol('sol3',Fx,setval(freq,f0*
(harm_exc))))

y

tor(rpm)*comp1.genext1(withsol('sol3',Fy,setval(freq,f0*
(harm_exc))))

z
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2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Meshed Section.

Size
1 In the Model Builder window, click Size.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type c0/fmax/5.

4 In the Minimum element size text field, type 3[mm].

5 Click Build All.

Size 1
1 In the Model Builder window, right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section.

5 Select the Maximum element size checkbox. In the associated text field, type 10[mm].

6 Select the Minimum element size checkbox. In the associated text field, type 0.3[mm].

7 Select the Maximum element growth rate checkbox. In the associated text field, type 
1.2.

8 Select the Curvature factor checkbox. In the associated text field, type 0.1.

9 Select Boundaries 301, 306, 331, 334, 337, 351, 354, 376, 379, 403, 406, 437, 445, 
464, 467, 496, 499, 505, 508, 525, 528, 949, 952, 957, 966, 969, 993, and 996 only.
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10 Click Build Selected.

The image should look like this.

As the geometry is build using an assembly, it is advisable to copy the mesh so the 
extrapolation of displacements at the boundary is simpler.

Copy Face 1
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 Select Boundary 431 only.

3 In the Settings window for Copy Face, locate the Destination Boundaries section.

4 Click to select the Activate Selection toggle button.

5 Select Boundary 916 only.

6 Click Build Selected.

Swept 1
1 In the Mesh toolbar, click Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Sweep Domain.
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5 Click Build Selected.

The image should look like this.

Free Tetrahedral 1
1 In the Mesh toolbar, click Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Tetrahedral Domains.

5 Click Build Selected.

Swept 2
1 In the Mesh toolbar, click Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose PML.

Distribution 1
1 Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.
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3 In the Number of elements text field, type 6.

4 Click Build Selected.

Boundary Layers 1
1 In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Geometric Entity Selection 
section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 9 only.

5 Click to expand the Transition section. Clear the Smooth transition to interior mesh 
checkbox.

Boundary Layer Properties
1 In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the Layers section.

3 In the Number of layers text field, type 1.

4 Locate the Boundary Selection section. From the Selection list, choose 
Exterior Field Calculation.

5 Click Build Selected.

The image should look like this.
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6 In the Model Builder window, click Mesh 2.

D E F I N I T I O N S  ( C O M P 2 )

Variables 2
1 In the Model Builder window, under Component 2 (comp2) right-click Definitions and 

choose Variables.

Add a few variables that will help you to postprocess the model.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Name Expression Unit Description

rpm acpr.freq/f0*rpm0/
harm_exc

Hz Revolutions

p_mic1 subst(abs(acpr.efc1.pex
t),x,0,y,0,z,z_mic1)

Pa Absolute pressure at 
microphone 1

spl_mic1 subst(acpr.efc1.Lp_pext
,x,0,y,0,z,z_mic1)

dB Sound pressure level 
at microphone 1
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Add a torque-speed normalized curve.

Torque curve
1 In the Definitions toolbar, click Analytic.

2 In the Settings window for Analytic, type Torque curve in the Label text field.

3 In the Function name text field, type tor.

4 Locate the Definition section. In the Expression text field, type if(rev<4000,1,4000/
rev).

5 In the Arguments text field, type rev.

6 Locate the Units section. In the table, enter the following settings:

7 In the Function text field, type 1.

8 Locate the Plot Parameters section. In the table, enter the following settings:

9 Click Plot.

The image should look like Figure 3.

An acoustic signal will be generated later. This signal is generated as the motor accelerates 
through time. Proceed to create a revolutions-time curve.

Revolutions ramp
1 In the Definitions toolbar, click Analytic.

2 In the Settings window for Analytic, type Revolutions ramp in the Label text field.

3 In the Function name text field, type rev_ramp.

4 Locate the Definition section. In the Expression text field, type 200+9800*t/20[s].

5 In the Arguments text field, type t.

p_mic2 subst(abs(acpr.efc1.pex
t),x,0,y,y_mic2,z,0)

Pa Absolute pressure at 
microphone 2

spl_mic2 subst(acpr.efc1.Lp_pext
,x,0,y,y_mic2,z,0)

dB Sound pressure level 
at microphone 2

Argument Unit

rev rpm

Plot Argument Lower 
limit

Upper limit Fixed 
value

Unit

√ rev 0 10000[rpm] 0 1/s

Name Expression Unit Description
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6 Locate the Units section. In the table, enter the following settings:

7 In the Function text field, type rpm.

8 Locate the Plot Parameters section. In the table, enter the following settings:

9 Click Plot.

The image should look like Figure 5.

Add a Perfectly Matched Layer domain to represent the open domain surrounding the 
motor.

Perfectly Matched Layer 1 (pml1)
1 In the Definitions toolbar, click Perfectly Matched Layer.

2 In the Settings window for Perfectly Matched Layer, locate the Domain Selection section.

3 From the Selection list, choose PML.

4 Locate the Scaling section. From the Coordinate stretching type list, choose Rational.

A D D  M A T E R I A L

1 In the Materials toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in > Air.

4 Click the Add to Component button in the window toolbar.

5 In the tree, select Built-in > Steel AISI 4340.

6 Click the Add to Component button in the window toolbar.

7 In the tree, select Built-in > Aluminum 6063-T83.

8 Click the Add to Component button in the window toolbar.

9 In the Materials toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Air (mat5)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

Argument Unit

t s

Plot Argument Lower limit Upper limit Fixed value Unit

√ t 0 20[s] 0 s
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2 From the Selection list, choose Air.

Steel AISI 4340 (mat6)
1 In the Model Builder window, click Steel AISI 4340 (mat6).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Iron.

Aluminum 6063-T83 (mat7)
1 In the Model Builder window, click Aluminum 6063-T83 (mat7).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Aluminum.

Coil
1 In the Model Builder window, right-click Materials and choose Blank Material.

The coils are made of copper wires. The stiffness of the wire assembly is significantly 
smaller than that of copper.

2 In the Settings window for Material, type Coil in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Coils.

4 Locate the Material Contents section. In the table, enter the following settings:

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve checkboxes 
for Magnetic Fields (mf) and Weak Form Boundary PDE (wb).

4 Find the Studies subsection. In the Select Study tree, select General Studies > 
Frequency Domain.

5 Click the Add Study button in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

Property Variable Value Unit Property group

Young’s modulus E 5[GPa] Pa Young’s modulus 
and Poisson’s ratio

Poisson’s ratio nu 0.3 1 Young’s modulus 
and Poisson’s ratio

Density rho 8960[kg/m^3] kg/m³ Basic
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S T U D Y  3

Step 1: Frequency Domain
This expression gives uniform steps through the sweep up to the maximum revolutions or 
frequency are reached.

1 In the Settings window for Frequency Domain, locate the Study Settings section.

2 In the Frequencies text field, type range(360[deg]/theta*rpm_idle*harm_exc,
fdelta,min(fmax,rpm_max/rpm0*f0*harm_exc)) min(fmax,rpm_max/rpm0*f0*

harm_exc).

3 Click to expand the Store in Output section. In the table, enter the following settings:

4 Click to select row number 3 in the table.

5 Under Selections, click Add.

6 In the Add dialog, select Exterior Field Calculation in the Selections list.

7 Click OK.

8 In the Settings window for Frequency Domain, locate the Store in Output section.

9 In the table, enter the following settings:

10 Click to select row number 4 in the table.

11 Under Selections, click Add.

12 In the Add dialog, select Exterior Field Calculation in the Selections list.

13 Click OK.

14 In the Model Builder window, click Study 3.

15 In the Settings window for Study, type Study 3 - Vibroacoustic Analysis - all 
Harmonics and Frequencies in the Label text field.

16 Locate the Study Settings section. Clear the Generate default plots checkbox.

Add a parametric sweep that will sequentially excite the different harmonics.

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

Interface Output

Pressure Acoustics, Frequency Domain (acpr) Selection

Interface Output

Solid Mechanics (solid) Selection
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2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 In the table, click to select the cell at row number 1 and column number 3.

Change the solver to a segregated solver, where the displacements will be obtained first 
and then used to compute the acoustic pressure.

Solution 4 (sol4)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 4 (sol4) node.

3 In the Model Builder window, expand the Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies > Solver Configurations > Solution 4 (sol4) > 
Stationary Solver 1 node.

4 Right-click Study 3 - Vibroacoustic Analysis - all Harmonics and Frequencies > 
Solver Configurations > Solution 4 (sol4) > Stationary Solver 1 and choose Segregated.

5 In the Settings window for Segregated, locate the General section.

6 From the Termination technique list, choose Iterations.

7 In the Model Builder window, expand the Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies > Solver Configurations > Solution 4 (sol4) > 
Stationary Solver 1 > Segregated 1 node, then click Segregated Step.

8 In the Settings window for Segregated Step, locate the General section.

9 In the Variables list box, select Acoustic Pressure (comp2.p).

10 Under Variables, click Delete.

11 In the Model Builder window, under Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies > Solver Configurations > Solution 4 (sol4) > 
Stationary Solver 1 right-click Segregated 1 and choose Segregated Step.

12 In the Settings window for Segregated Step, locate the General section.

13 Under Variables, click Add.

14 In the Add dialog, select Acoustic Pressure (comp2.p) in the Variables list.

15 Click OK.

Parameter name Parameter value list Parameter unit

harm_exc (Harmonic excited in 
the vibroacoustic analysis)

range(1,1,n_harmonics)
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16 In the Model Builder window, under Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies > Solver Configurations > Solution 4 (sol4) > 
Stationary Solver 1 click Suggested Direct Solver (asb1).

17 In the Settings window for Direct, locate the General section.

18 From the Solver list, choose PARDISO.

19 In the Model Builder window, click Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies.

20 In the Settings window for Study, locate the Study Settings section.

21 Clear the Generate convergence plots checkbox.

Due to the many frequencies requested, expect a long running time.

22 In the Study toolbar, click Compute.

R E S U L T S

Study 3 - Vibroacoustic Analysis - all Harmonics and Frequencies/Parametric Solutions 1 
(6) (sol5), Study 3 - Vibroacoustic Analysis - all Harmonics and Frequencies/Solution 4 
(4) (sol4), Study 3 - Vibroacoustic Analysis - all Harmonics and Frequencies/Solution 4 
(5) (sol4)
1 In the Model Builder window, under Results > Datasets, Ctrl-click to select Study 3 -

Vibroacoustic Analysis - all Harmonics and Frequencies/Solution 4 (4) (sol4), Study 3 -

Vibroacoustic Analysis - all Harmonics and Frequencies/Solution 4 (5) (sol4), and Study 3 -

Vibroacoustic Analysis - all Harmonics and Frequencies/Parametric Solutions 1 (6) (sol5).

2 Right-click and choose Delete.

Campbell Diagram, First Microphone
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Campbell Diagram, First 
Microphone in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies/Parametric Solutions 1 (sol5).

4 Locate the Title section. From the Title type list, choose Label.

Global 1
1 Right-click Campbell Diagram, First Microphone and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.
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3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Parameter list, choose Expression.

5 In the Expression text field, type rpm.

6 In the Unit field, type RPM.

7 Click to expand the Coloring and Style section. From the Width list, choose 3.

8 Click to expand the Legends section. Clear the Show legends checkbox.

Color Expression 1
1 Right-click Global 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type spl_mic1.

4 From the Unit list, choose dB.

5 In the Campbell Diagram, First Microphone toolbar, click Plot.

6 Click to expand the Range section. Select the Manual color range checkbox.

7 In the Minimum text field, type 55.

8 In the Maximum text field, type 80.

Campbell Diagram, First Microphone
1 In the Model Builder window, under Results click Campbell Diagram, First Microphone.

2 In the Settings window for 1D Plot Group, locate the Color Legend section.

3 Select the Show maximum and minimum values checkbox.

4 Select the Show units checkbox.

5 In the Campbell Diagram, First Microphone toolbar, click Plot.

The image should look like Figure 13.

Campbell Diagram, Second Microphone
1 Right-click Campbell Diagram, First Microphone and choose Duplicate.

2 In the Model Builder window, click Campbell Diagram, First Microphone 1.

3 In the Settings window for 1D Plot Group, type Campbell Diagram, Second 
Microphone in the Label text field.

Expression Unit Description

acpr.freq Hz Frequency
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Color Expression 1
1 In the Model Builder window, expand the Results > Campbell Diagram, Second Microphone 

> Global 1 node, then click Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type spl_mic2.

4 Locate the Range section. In the Maximum text field, type 100.

5 In the Campbell Diagram, Second Microphone toolbar, click Plot.

The image should look like Figure 13.

Exterior-Field Sound Pressure Level (acpr)
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Exterior-Field Sound Pressure 
Level (acpr) in the Label text field.

3 Locate the Data section. From the Parameter value (harm_exc) list, choose 3.

4 From the Parameter value (freq (Hz)) list, choose 2600.

5 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

6 Select the Show units checkbox.

Radiation Pattern 1
1 In the Exterior-Field Sound Pressure Level (acpr) toolbar, click More Plots and choose 

Radiation Pattern.

2 In the Settings window for Radiation Pattern, locate the Expression section.

3 In the Expression text field, type acpr.efc1.Lp_pext/80.

4 Select the Description checkbox. In the associated text field, type Exterior-field 
sound pressure level.

5 Clear the Use as color expression checkbox.

6 Click to expand the Range section. Select the Manual color range checkbox.

7 In the Minimum text field, type 65.

8 In the Maximum text field, type 75.

9 Locate the Evaluation section. Find the Angles subsection. In the 
Number of elevation angles text field, type 160.

10 In the Number of azimuth angles text field, type 240.

11 From the Restriction list, choose Manual.
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12 In the θ range text field, type 90.

13 In the φ start text field, type -90.

14 In the φ range text field, type 270.

15 Find the Sphere subsection. From the Sphere list, choose Manual.

16 In the Radius text field, type 0.5.

17 Locate the Coloring and Style section. From the Grid list, choose Fine.

18 In the Exterior-Field Sound Pressure Level (acpr) toolbar, click Plot.

Exterior-Field Sound Pressure Level (acpr)
1 In the Model Builder window, click Exterior-Field Sound Pressure Level (acpr).

2 In the Settings window for 3D Plot Group, locate the Plot Settings section.

3 Select the Plot dataset edges checkbox.

4 In the Exterior-Field Sound Pressure Level (acpr) toolbar, click Plot.

5 Click the Show Grid button in the Graphics toolbar.

The image should look like this.
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Campbell Diagram, First Microphone, Campbell Diagram, Second Microphone, Exterior-
Field Sound Pressure Level (acpr)
1 In the Model Builder window, under Results, Ctrl-click to select Campbell Diagram,

First Microphone, Campbell Diagram, Second Microphone, and Exterior-

Field Sound Pressure Level (acpr).

2 Right-click and choose Group.

Vibroacoustic Results - all Harmonics and Frequencies
In the Settings window for Group, type Vibroacoustic Results - all Harmonics and 
Frequencies in the Label text field.

Pressure - Revolutions - 1st Harmonic
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 1st 
Harmonic in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 3 - Vibroacoustic Analysis -

all Harmonics and Frequencies/Parametric Solutions 1 (sol5).

4 From the Parameter selection (harm_exc) list, choose From list.

5 In the Parameter values (harm_exc) list box, select 1.

6 Click to expand the Format section. From the Include parameters list, choose Off.

Global Evaluation 1
1 Right-click Pressure - Revolutions - 1st Harmonic and choose Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 In the Pressure - Revolutions - 1st Harmonic toolbar, click Evaluate.

Expression Unit Description

rpm RPM Regime for the excited 
harmonic

subst(real(acpr.efc1.pext),x,
0.1[m],y,y_mic2,z,0)

Pa Absolute pressure at 
microphone 2 - Left Real

subst(imag(acpr.efc1.pext),x,
0.1[m],y,y_mic2,z,0)

Pa Absolute pressure at 
microphone 2 - Left Imag

subst(real(acpr.efc1.pext),x,-
0.1[m],y,y_mic2,z,0)

Pa Absolute pressure at 
microphone 2 - Right Real

subst(imag(acpr.efc1.pext),x,-
0.1[m],y,y_mic2,z,0)

Pa Absolute pressure at 
microphone 2 - Right Imag
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Pressure - Revolutions - 2nd Harmonic
1 In the Model Builder window, right-click Pressure - Revolutions - 1st Harmonic and 

choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 2nd 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 2.

4 In the Pressure - Revolutions - 2nd Harmonic toolbar, click Evaluate.

Pressure - Revolutions - 3rd Harmonic
1 Right-click Pressure - Revolutions - 2nd Harmonic and choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 3rd 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 3.

4 In the Pressure - Revolutions - 3rd Harmonic toolbar, click Evaluate.

Pressure - Revolutions - 4th Harmonic
1 Right-click Pressure - Revolutions - 3rd Harmonic and choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 4th 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 4.

4 In the Pressure - Revolutions - 4th Harmonic toolbar, click Evaluate.

Pressure - Revolutions - 5th Harmonic
1 Right-click Pressure - Revolutions - 4th Harmonic and choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 5th 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 5.

4 In the Pressure - Revolutions - 5th Harmonic toolbar, click Evaluate.

Pressure - Revolutions - 6th Harmonic
1 Right-click Pressure - Revolutions - 5th Harmonic and choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 6th 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 6.

4 In the Pressure - Revolutions - 6th Harmonic toolbar, click Evaluate.
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Pressure - Revolutions - 7th Harmonic
1 Right-click Pressure - Revolutions - 6th Harmonic and choose Duplicate.

2 In the Settings window for Evaluation Group, type Pressure - Revolutions - 7th 
Harmonic in the Label text field.

3 Locate the Data section. In the Parameter values (harm_exc) list box, select 7.

4 In the Pressure - Revolutions - 7th Harmonic toolbar, click Evaluate.

Pressure - Revolutions - 1st Harmonic, Pressure - Revolutions - 2nd Harmonic, Pressure 
- Revolutions - 3rd Harmonic, Pressure - Revolutions - 4th Harmonic, Pressure - 
Revolutions - 5th Harmonic, Pressure - Revolutions - 6th Harmonic, Pressure - 
Revolutions - 7th Harmonic
1 In the Model Builder window, under Results, Ctrl-click to select Pressure - Revolutions -

1st Harmonic, Pressure - Revolutions - 2nd Harmonic, Pressure - Revolutions -

3rd Harmonic, Pressure - Revolutions - 4th Harmonic, Pressure - Revolutions -

5th Harmonic, Pressure - Revolutions - 6th Harmonic, and Pressure - Revolutions -

7th Harmonic.

2 Right-click and choose Group.

Acoustic Signal
In the Settings window for Group, type Acoustic Signal in the Label text field.

D E F I N I T I O N S  ( C O M P 2 )

Interpolation 1 (int1)
1 In the Definitions toolbar, click Interpolation.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Data source list, choose Result table.

4 Locate the Data Column Settings section. In the table, enter the following settings:

5 In the table, click to select the cell at row number 1 and column number 1.

6 In the Unit text field, type RPM.

Columns Type Settings

Absolute pressure at microphone 2 
- Left Imag (Pa)

Function values Function name=int1a

Absolute pressure at microphone 2 
- Right Real (Pa)

Function values Function name=int1b

Absolute pressure at microphone 2 
- Right Imag (Pa)

Function values Function name=int1c
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7 In the table, click to select the cell at row number 2 and column number 1.

8 In the Name text field, type real1_l.

9 In the Unit text field, type Pa.

10 In the table, click to select the cell at row number 3 and column number 1.

11 In the Name text field, type imag1_l.

12 In the Unit text field, type Pa.

13 In the table, click to select the cell at row number 4 and column number 1.

14 In the Name text field, type real1_r.

15 In the Unit text field, type Pa.

16 In the table, click to select the cell at row number 5 and column number 1.

17 In the Name text field, type imag1_r.

18 In the Unit text field, type Pa.

19 Locate the Interpolation and Extrapolation section. From the Interpolation list, choose 
Piecewise cubic.

20 From the Extrapolation list, choose Specific value.

21 Click Plot.

Interpolation 2 (real1_l2, imag1_l2, ...)
1 Right-click Interpolation 1 (real1_l, imag1_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 2nd Harmonic.

4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real2_l.

6 In the table, click to select the cell at row number 3 and column number 1.

7 In the Name text field, type imag2_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real2_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag2_r.

12 Click Plot.
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Interpolation 3 (real2_l3, imag2_l3, ...)
1 Right-click Interpolation 2 (real2_l, imag2_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 3rd Harmonic.

4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real3_l.

6 In the table, click to select the cell at row number 3 and column number 1.

7 In the Name text field, type imag3_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real3_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag3_r.

12 Click Plot.

Interpolation 4 (real3_l4, imag3_l4, ...)
1 Right-click Interpolation 3 (real3_l, imag3_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 4th Harmonic.

4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real4_l.

6 In the table, click to select the cell at row number 3 and column number 1.

7 In the Name text field, type imag4_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real4_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag4_r.

12 Click Plot.

Interpolation 5 (real4_l5, imag4_l5, ...)
1 Right-click Interpolation 4 (real4_l, imag4_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 5th Harmonic.
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4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real5_l.

6 In the table, click to select the cell at row number 3 and column number 1.

7 In the Name text field, type imag5_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real5_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag5_r.

12 Click Plot.

Interpolation 6 (real5_l6, imag5_l6, ...)
1 Right-click Interpolation 5 (real5_l, imag5_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 6th Harmonic.

4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real6_l.

6 In the table, click to select the cell at row number 3 and column number 1.

7 In the Name text field, type imag6_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real6_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag6_r.

12 Click Plot.

Interpolation 7 (real6_l7, imag6_l7, ...)
1 Right-click Interpolation 6 (real6_l, imag6_l, ...) and choose Duplicate.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Table from list, choose Pressure - Revolutions - 7th Harmonic.

4 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 2 and column number 1.

5 In the Name text field, type real7_l.

6 In the table, click to select the cell at row number 3 and column number 1.
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7 In the Name text field, type imag7_l.

8 In the table, click to select the cell at row number 4 and column number 1.

9 In the Name text field, type real7_r.

10 In the table, click to select the cell at row number 5 and column number 1.

11 In the Name text field, type imag7_r.

12 Click Plot.

Interpolation 1 (real1_l, imag1_l, ...), Interpolation 2 (real2_l, imag2_l, ...), Interpolation 
3 (real3_l, imag3_l, ...), Interpolation 4 (real4_l, imag4_l, ...), Interpolation 5 (real5_l, 
imag5_l, ...), Interpolation 6 (real6_l, imag6_l, ...), Interpolation 7 (real7_l, imag7_l, ...)
1 In the Model Builder window, under Component 2 (comp2) > Definitions, Ctrl-click to 

select Interpolation 1 (real1_l, imag1_l, ...), Interpolation 2 (real2_l, imag2_l, ...), 
Interpolation 3 (real3_l, imag3_l, ...), Interpolation 4 (real4_l, imag4_l, ...), 
Interpolation 5 (real5_l, imag5_l, ...), Interpolation 6 (real6_l, imag6_l, ...), and 
Interpolation 7 (real7_l, imag7_l, ...).

2 Right-click and choose Group.

Acoustic Signal
In the Settings window for Group, type Acoustic Signal in the Label text field.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve checkboxes 
for Magnetic Fields (mf) and Weak Form Boundary PDE (wb).

4 Find the Studies subsection. In the Select Study tree, select General Studies > 
Frequency Domain.

5 Click the Add Study button in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  4

Step 1: Frequency Domain
1 In the Settings window for Frequency Domain, locate the Study Settings section.

2 In the Frequencies text field, type 2360.

3 In the Model Builder window, click Study 4.
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4 In the Settings window for Study, type Study 4 - Vibroacoustic Analysis - 3rd 
Harmonic 2360 Hz in the Label text field.

5 Locate the Study Settings section. Clear the Generate default plots checkbox.

6 Clear the Generate convergence plots checkbox.

Change the solver to a segregated solver, where the displacements will be obtained first 
and then used to compute the acoustic pressure.

Solution 13 (sol13)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 13 (sol13) node.

3 In the Model Builder window, expand the Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz > Solver Configurations > Solution 13 (sol13) > Stationary Solver 1 
node.

4 Right-click Study 4 - Vibroacoustic Analysis - 3rd Harmonic 2360 Hz > 
Solver Configurations > Solution 13 (sol13) > Stationary Solver 1 and choose Segregated.

5 In the Settings window for Segregated, locate the General section.

6 From the Termination technique list, choose Iterations.

7 In the Model Builder window, expand the Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz > Solver Configurations > Solution 13 (sol13) > Stationary Solver 1 
> Segregated 1 node, then click Segregated Step.

8 In the Settings window for Segregated Step, locate the General section.

9 In the Variables list box, select Acoustic Pressure (comp2.p).

10 Under Variables, click Delete.

11 In the Model Builder window, under Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz > Solver Configurations > Solution 13 (sol13) > Stationary Solver 1 
right-click Segregated 1 and choose Segregated Step.

12 In the Settings window for Segregated Step, locate the General section.

13 Under Variables, click Add.

14 In the Add dialog, select Acoustic Pressure (comp2.p) in the Variables list.

15 Click OK.

16 In the Study toolbar, click Compute.
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R E S U L T S

Study 4 - Vibroacoustic Analysis - 3rd Harmonic 2360 Hz/Solution 13 (8) (sol13)
In the Model Builder window, under Results > Datasets right-click Study 4 -

Vibroacoustic Analysis - 3rd Harmonic 2360 Hz/Solution 13 (8) (sol13) and choose Delete.

Grid 1D 1
1 In the Results toolbar, click More Datasets and choose Grid > Grid 1D.

2 In the Settings window for Grid 1D, locate the Data section.

3 From the Dataset list, choose Study 4 - Vibroacoustic Analysis - 3rd Harmonic 2360 Hz/

Solution 13 (sol13).

4 Locate the Parameter Bounds section. In the Name text field, type tt.

5 In the Maximum text field, type 20.

6 Click to expand the Grid section. In the Resolution text field, type 960000.

Acoustic Signal
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Acoustic Signal in the Label text field.

3 Locate the Data section. From the Dataset list, choose Grid 1D 1.

4 Locate the Title section. From the Title type list, choose Label.

5 Locate the Plot Settings section.

6 Select the y-axis label checkbox. In the associated text field, type Signal (Pa).

Left Channel
1 Right-click Acoustic Signal and choose Line Graph.

2 In the Settings window for Line Graph, type Left Channel in the Label text field.

3 Locate the y-Axis Data section.

4 Select the Description checkbox. In the associated text field, type Left Channel.

5 In the Expression text field, type real((real1_l(rev_ramp(tt))+i*
imag1_l(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*1*pi*tt)+

(real2_l(rev_ramp(tt))+i*imag2_l(rev_ramp(tt)))*exp(i*

(rev_ramp(tt))*f0/rpm0*2*pi*tt)+(real3_l(rev_ramp(tt))+i*

imag3_l(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*3*pi*tt)+

(real4_l(rev_ramp(tt))+i*imag4_l(rev_ramp(tt)))*exp(i*

(rev_ramp(tt))*f0/rpm0*4*pi*tt)+(real5_l(rev_ramp(tt))+i*

imag5_l(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*5*pi*tt)+

(real6_l(rev_ramp(tt))+i*imag6_l(rev_ramp(tt)))*exp(i*
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(rev_ramp(tt))*f0/rpm0*6*pi*tt)+(real7_l(rev_ramp(tt))+i*

imag7_l(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*7*pi*tt)).

6 Locate the x-Axis Data section. From the Parameter list, choose Expression.

7 In the Expression text field, type tt[s/m].

8 Select the Description checkbox. In the associated text field, type time.

9 Click to expand the Legends section. Select the Show legends checkbox.

10 Find the Include subsection. Clear the Solution checkbox.

11 Select the Label checkbox.

12 In the Acoustic Signal toolbar, click Plot.

Right Channel
1 Right-click Left Channel and choose Duplicate.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Description text field, type Right Channel.

4 In the Expression text field, type real((real1_r(rev_ramp(tt))+i*
imag1_r(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*1*pi*tt)+

(real2_r(rev_ramp(tt))+i*imag2_r(rev_ramp(tt)))*exp(i*

(rev_ramp(tt))*f0/rpm0*2*pi*tt)+(real3_r(rev_ramp(tt))+i*

imag3_r(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*3*pi*tt)+

(real4_r(rev_ramp(tt))+i*imag4_r(rev_ramp(tt)))*exp(i*

(rev_ramp(tt))*f0/rpm0*4*pi*tt)+(real5_r(rev_ramp(tt))+i*

imag5_r(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*5*pi*tt)+

(real6_r(rev_ramp(tt))+i*imag6_r(rev_ramp(tt)))*exp(i*

(rev_ramp(tt))*f0/rpm0*6*pi*tt)+(real7_r(rev_ramp(tt))+i*

imag7_r(rev_ramp(tt)))*exp(i*(rev_ramp(tt))*f0/rpm0*7*pi*tt)).

5 In the Label text field, type Right Channel.
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6 In the Acoustic Signal toolbar, click Plot.

The image should look like this.

Left Channel Acoustic Signal
1 In the Model Builder window, under Results > Vibroacoustic Results -

all Harmonics and Frequencies > Acoustic Signal right-click Left Channel and choose 
Add Plot Data to Export.

2 In the Settings window for Plot, type Left Channel Acoustic Signal in the Label 
text field.

3 Locate the Output section. From the File type list, choose WAV audio file (*.wav; *.wave).

4 In the Filename text field, type electric_motor_noise_left.wav.

5 Click Export to produce a WAV-file with the acoustic signal at the left channel.

Right Channel Acoustic Signal
1 In the Model Builder window, under Results > Vibroacoustic Results -

all Harmonics and Frequencies > Acoustic Signal right-click Right Channel and choose 
Add Plot Data to Export.

2 In the Settings window for Plot, type Right Channel Acoustic Signal in the Label 
text field.

3 Locate the Output section. From the File type list, choose WAV audio file (*.wav; *.wave).
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4 In the Filename text field, type electric_motor_noise_right.wav.

5 Click Export to produce a WAV-file with the acoustic signal at the right channel.

Displacement and Acoustic Pressure
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Displacement and Acoustic 
Pressure in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz/Solution 13 (sol13).

4 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

5 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

6 Select the Show units checkbox.

Surface 1
1 Right-click Displacement and Acoustic Pressure and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.disp.

Deformation 1
Right-click Surface 1 and choose Deformation.

Filter 1
1 In the Model Builder window, right-click Surface 1 and choose Filter.

2 In the Settings window for Filter, locate the Element Selection section.

3 In the Logical expression for inclusion text field, type x>-40.5[mm].

4 In the Displacement and Acoustic Pressure toolbar, click Plot.

Line 1
1 In the Model Builder window, right-click Displacement and Acoustic Pressure and choose 

Line.

2 In the Settings window for Line, locate the Expression section.

3 In the Expression text field, type 0.

4 Click to expand the Title section. From the Title type list, choose None.

5 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

6 From the Color list, choose Black.
70 |  E L E C T R I C  M O T O R  N O I S E :  P E R M A N E N T  M A G N E T  S Y N C H R O N O U S  M O T O R



Deformation 1
In the Model Builder window, under Results > Displacement and Acoustic Pressure > 
Surface 1 right-click Deformation 1 and choose Copy.

Deformation 1
In the Model Builder window, right-click Line 1 and choose Paste Deformation.

Filter 1
In the Model Builder window, under Results > Displacement and Acoustic Pressure > 
Surface 1 right-click Filter 1 and choose Copy.

Filter 1
In the Model Builder window, right-click Line 1 and choose Paste Filter.

Line 1
1 In the Settings window for Line, click to expand the Inherit Style section.

2 From the Plot list, choose Surface 1.

3 Clear the Color checkbox.

4 Clear the Color and data range checkbox.

5 In the Displacement and Acoustic Pressure toolbar, click Plot.

Isosurface 1
1 In the Model Builder window, right-click Displacement and Acoustic Pressure and choose 

Isosurface.

2 In the Settings window for Isosurface, locate the Levels section.

3 In the Total levels text field, type 11.

Selection 1
1 Right-click Isosurface 1 and choose Selection.

2 Select Domain 9 only.

Filter 1
In the Model Builder window, under Results > Displacement and Acoustic Pressure > Line 1 
right-click Filter 1 and choose Copy.

Filter 1
In the Model Builder window, right-click Isosurface 1 and choose Paste Filter.

Displacement and Acoustic Pressure
1 In the Displacement and Acoustic Pressure toolbar, click Plot.

The image should look like Figure 11.
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SPL and Radiation Pattern
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type SPL and Radiation Pattern in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz/Solution 13 (sol13).

4 Locate the Plot Settings section. From the View list, choose New view.

5 Click to expand the Selection section. From the Geometric entity level list, choose 
Domain.

6 From the Selection list, choose Structure.

7 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

8 Locate the Color Legend section. Select the Show units checkbox.

Surface 1
1 Right-click SPL and Radiation Pattern and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type acpr.Lp.

4 Click to expand the Range section. Select the Manual color range checkbox.

5 In the Minimum text field, type 80.

6 In the Maximum text field, type 115.

Deformation 1
Right-click Surface 1 and choose Deformation.

Line 1
1 In the Model Builder window, right-click SPL and Radiation Pattern and choose Line.

2 In the Settings window for Line, locate the Expression section.

3 In the Expression text field, type 0.

4 Locate the Title section. From the Title type list, choose None.

5 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

6 From the Color list, choose Black.

7 Locate the Inherit Style section. From the Plot list, choose Surface 1.

8 Clear the Color checkbox.

9 Clear the Color and data range checkbox.
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Deformation 1
Right-click Line 1 and choose Deformation.

Radiation Pattern 1
1 In the Model Builder window, expand the Results > Vibroacoustic Results -

all Harmonics and Frequencies > Exterior-Field Sound Pressure Level (acpr) node.

2 Right-click Radiation Pattern 1 and choose Copy.

Radiation Pattern 1
1 In the Model Builder window, right-click SPL and Radiation Pattern and choose 

Paste Radiation Pattern.

2 In the Settings window for Radiation Pattern, locate the Range section.

3 In the Maximum text field, type 85.

4 Locate the Evaluation section. Find the Angles subsection. In the φ range text field, type 
360.

Transparency 1
1 Right-click Radiation Pattern 1 and choose Transparency.

2 Click the Zoom Extents button in the Graphics toolbar.

The image should look like Figure 12.

Boundary Loads
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Boundary Loads in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 4 - Vibroacoustic Analysis -

3rd Harmonic 2360 Hz/Solution 13 (sol13).

4 Locate the Selection section. From the Geometric entity level list, choose Domain.

5 From the Selection list, choose Structure.

6 Select the Apply to dataset edges checkbox.

7 Locate the Color Legend section. Select the Show units checkbox.

Arrow Surface 1
1 Right-click Boundary Loads and choose Arrow Surface.

2 In the Settings window for Arrow Surface, locate the Expression section.

3 In the X-component text field, type solid.bndl1.fax.

4 In the Y-component text field, type solid.bndl1.fay.

5 In the Z-component text field, type solid.bndl1.faz.
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6 Locate the Arrow Positioning section. From the Placement list, choose Gauss points.

Color Expression 1
1 Right-click Arrow Surface 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type comp2.solid.bndl1.famag.

4 Locate the Coloring and Style section. From the Coloring list, choose Gradient.

5 From the Top color list, choose Red.

6 Click the Orthographic Projection button in the Graphics toolbar.

7 Click the Go to YZ View button in the Graphics toolbar.

The image should look like Figure 10.

Boundary Loads, Displacement and Acoustic Pressure, SPL and Radiation Pattern
1 In the Model Builder window, under Results, Ctrl-click to select 

Displacement and Acoustic Pressure, SPL and Radiation Pattern, and Boundary Loads.

2 Right-click and choose Group.

Vibroacoustic Results - 3rd Harmonic 2360 Hz
In the Settings window for Group, type Vibroacoustic Results - 3rd Harmonic 2360 
Hz in the Label text field.

Geometry Sequence Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.
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3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
electric_motor_noise_pmsm_geom_sequence_parameters.txt.

G E O M E T R Y  1

Import 1 (imp1)
1 In the Geometry toolbar, click Import.

2 In the Settings window for Import, locate the Source section.

3 From the Source list, choose COMSOL Multiphysics file.

4 Click Browse.

5 Browse to the model’s Application Libraries folder and double-click the file 
electric_motor_noise_pmsm_geom_sequence.mphbin.

6 Click Import.

7 Click the Wireframe Rendering button in the Graphics toolbar.

Work Plane 1 (wp1)
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose yz-plane.

4 From the Offset type list, choose Through vertex.

5 Click to select the Activate Selection toggle button for Offset vertex.

6 On the object imp1, select Point 372 only.

Work Plane 1 (wp1) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 1 (wp1) > Circle 1 (c1)
1 In the Work Plane toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type r_stator.

4 Click to expand the Layers section. In the table, enter the following settings:

Layer name Thickness (m)

Layer 1 th_out_stator

Layer 2 h_stat-th_out_stator

Layer 3 air_gap/2
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5 Click Build Selected.

Work Plane 1 (wp1) > Polygon 1 (pol1)
1 In the Work Plane toolbar, click Polygon.

2 In the Settings window for Polygon, locate the Coordinates section.

3 In the table, enter the following settings:

4 Click Build Selected.

Work Plane 1 (wp1) > Polygon 2 (pol2)
1 In the Work Plane toolbar, click Polygon.

2 In the Settings window for Polygon, locate the Coordinates section.

3 In the table, enter the following settings:

4 Click Build Selected.

Work Plane 1 (wp1) > Union 1 (uni1)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Select the objects pol1 and pol2 only.

xw (m) yw (m)

(r_stator-h_stat+th_in_stator) 0

(r_stator-h_stat+th_in_stator+
h_coil_angle)*cos(-angle_coil/2)

(r_stator-h_stat+th_in_stator+
h_coil_angle)*sin(-angle_coil/2)

(r_stator-th_out_stator)*cos(-
angle_coil/2)

(r_stator-th_out_stator)*sin(-
angle_coil/2)

(r_stator-th_out_stator/2) 0

(r_stator-th_out_stator)*
cos(angle_coil/2)

(r_stator-th_out_stator)*
sin(angle_coil/2)

(r_stator-h_stat+th_in_stator+
h_coil_angle)*cos(angle_coil/2)

(r_stator-h_stat+th_in_stator+
h_coil_angle)*sin(angle_coil/2)

xw (m) yw (m)

(r_stator-h_stat)*cos(-
angle_teeth_gap/2)

(r_stator-h_stat)*sin(-
angle_teeth_gap/2)

(r_stator-th_out_stator)*cos(-
angle_teeth_gap/2)

(r_stator-th_out_stator)*sin(-
angle_teeth_gap/2)

(r_stator-th_out_stator)*cos(+
angle_teeth_gap/2)

(r_stator-th_out_stator)*sin(+
angle_teeth_gap/2)

(r_stator-h_stat)*cos(+
angle_teeth_gap/2)

(r_stator-h_stat)*sin(+
angle_teeth_gap/2)
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3 In the Settings window for Union, click Build Selected.

Work Plane 1 (wp1) > Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object c1, select Boundaries 1–12 only.

3 On the object uni1, select Boundaries 1, 4, 5, and 12–14 only.

4 In the Settings window for Delete Entities, click Build Selected.

Work Plane 1 (wp1) > Rotate 1 (rot1)
1 In the Work Plane toolbar, click Transforms and choose Rotate.

2 Select the object del1(2) only.

3 In the Settings window for Rotate, locate the Rotation section.

4 In the Angle text field, type range(360/(3*n_sectors),360/(3*n_sectors),360).

5 Click Build Selected.

Work Plane 1 (wp1) > Union 2 (uni2)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Union, click Build Selected.

Work Plane 1 (wp1) > Delete Entities 2 (del2)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni2, select Boundaries 75, 76, 83, 84, 91, 92, 99–102, 113, 114, 121–
124, 127, 128, 135, and 136 only.

3 In the Settings window for Delete Entities, click Build Selected.

Work Plane 1 (wp1) > Delete Entities 3 (del3)
1 Right-click Plane Geometry and choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete 
section.

3 From the Geometric entity level list, choose Domain.

4 On the object del2, select Domain 21 only.

5 Click Build Selected.

Work Plane 1 (wp1) > Fillet 1 (fil1)
1 In the Work Plane toolbar, click Fillet.

2 On the object del3, select Points 22–25, 38–41, 54, 55, 58, 59, 70–73, 81, and 82 only.
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3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type fillet.

5 Click Build Selected.

Extrude 1 (ext1)
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 right-click 

Work Plane 1 (wp1) and choose Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 From the Specify list, choose Vertices to extrude to.

4 On the object imp1, select Point 490 only.

5 Click Build Selected.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select both objects.

3 In the Settings window for Union, click Build Selected.

Work Plane 2 (wp2)
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose yz-plane.

4 From the Offset type list, choose Through vertex.

5 Click to select the Activate Selection toggle button for Offset vertex.

6 On the object uni1, select Point 422 only.

Work Plane 2 (wp2) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 2 (wp2) > Circle 1 (c1)
1 In the Work Plane toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type r_stator-h_stat-air_gap/2.

4 Locate the Layers section. In the table, enter the following settings:

Layer name Thickness (m)

Layer 1 air_gap/2
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5 Click Build Selected.

Work Plane 2 (wp2) > Line Segment 1 (ls1)
1 In the Work Plane toolbar, click More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type (r_stator-h_stat-air_gap-th_magnet)*cos(-
angle_magnet/2).

5 In the yw text field, type (r_stator-h_stat-air_gap-th_magnet)*sin(-
angle_magnet/2).

6 Locate the Endpoint section. From the Specify list, choose Coordinates.

7 In the xw text field, type (r_stator-h_stat-air_gap)*cos(-angle_magnet/2).

8 In the yw text field, type (r_stator-h_stat-air_gap)*sin(-angle_magnet/2).

9 Click Build Selected.

Work Plane 2 (wp2) > Rotate 1 (rot1)
1 In the Work Plane toolbar, click Transforms and choose Rotate.

2 Select the object ls1 only.

3 In the Settings window for Rotate, locate the Rotation section.

4 In the Angle text field, type range(360/(n_poles),360/(n_poles),360) 
range(360/(n_poles)+angle_magnet,360/(n_poles),360+angle_magnet).

5 Click Build Selected.

Work Plane 2 (wp2) > Union 1 (uni1)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Select the object c1 only.

3 Click the Select All button in the Graphics toolbar.

4 In the Settings window for Union, click Build Selected.

Work Plane 2 (wp2) > Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1, 2, 5, 10–15, 18, 23, 24, 27, 28, 35, 36, 57, 
58, 63, and 64 only.

Layer 2 th_magnet

Layer 3 r_stator-h_stat-air_gap-th_magnet-r_shaft

Layer name Thickness (m)
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3 In the Settings window for Delete Entities, click Build Selected.

Work Plane 2 (wp2) > Fillet 1 (fil1)
1 In the Work Plane toolbar, click Fillet.

2 On the object del1, select Points 2, 3, 7–10, 29–32, 36, and 37 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type fillet.

5 Click Build Selected.

Extrude 2 (ext2)
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 right-click 

Work Plane 2 (wp2) and choose Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 From the Specify list, choose Vertices to extrude to.

4 On the object uni1, select Point 656 only.

5 Click Build Selected.

Work Plane 3 (wp3)
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose yz-plane.

4 Click Build Selected.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 click 

Form Union (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 From the Action list, choose Form an assembly.

4 In the Geometry toolbar, click Build All.

Iron
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Iron in the Label text field.

3 On the object fin, select Domains 13, 24, and 49 only.

Coils
1 In the Geometry toolbar, click Selections and choose Explicit Selection.
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2 In the Settings window for Explicit Selection, type Coils in the Label text field.

3 On the object fin, select Domains 25, 26, and 28–43 only.

Aluminum
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Aluminum in the Label text field.

3 On the object fin, select Domains 14–17, 19–22, 45–47, and 50–52 only.

Structure
1 In the Geometry toolbar, click Selections and choose Union Selection.

2 In the Settings window for Union Selection, type Structure in the Label text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog, in the Selections to add list, choose Iron, Coils, and Aluminum.

5 Click OK.

Interior Cavity
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Interior Cavity in the Label text 
field.

3 On the object fin, select Domains 18, 23–44, 48, and 59–67 only.

PML
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type PML in the Label text field.

3 On the object fin, select Domains 1–8, 10–12, and 53–58 only.

Air
1 In the Geometry toolbar, click Selections and choose Complement Selection.

2 In the Settings window for Complement Selection, type Air in the Label text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog, in the Selections to invert list, choose Structure and Interior Cavity.

5 Click OK.

Loaded Boundaries
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Loaded Boundaries in the Label text 
field.
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3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object fin, select Boundaries 335, 336, 338, 339, 347, 349, 352, 355, 359, 360, 
366, 367, 371, 372, 374, 375, 377, 378, 380–385, 389–394, 396, 398, 401, 402, 404, 
407, 413–422, 425–428, 438–441, 444, 446–448, 450, 451, 456, 457, 460–463, 466, 
469–477, 486–495, 497, 498, 500, 501, 506, 509, 514–517, 520, 521, 523, 524, 526, 
529, 532–537, and 553–556 only.

Exterior Field Calculation
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Exterior Field Calculation in 
the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object fin, select Boundaries 31, 32, 36, 39, and 924 only.

Fixed Boundaries
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Fixed Boundaries in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object fin, select Boundaries 213, 214, 217, 247, 249, 257, 291, 292, 294–297, 
299, 300, 581, 582, 597, 690, 692, 719, 725, 726, 728–731, 733, and 734 only.

Meshed Section
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Meshed Section in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object fin, select Boundaries 301, 306, 317, 331, 334, 337, 351, 354, 376, 379, 
403, 406, 431, 437, 445, 464, 467, 496, 499, 505, 508, 525, 528, 538, 949, 952, 957, 
966, 969, 976, 993, and 996 only.

Sweep Domain
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Sweep Domain in the Label text field.
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3 On the object fin, select Domains 13, 21–26, 28–44, 49, and 60–67 only.

Tetrahedral Domains
1 In the Geometry toolbar, click Selections and choose Complement Selection.

2 In the Settings window for Complement Selection, type Tetrahedral Domains in the 
Label text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog, in the Selections to invert list, choose Interior Cavity, PML, and 
Sweep Domain.

5 Click OK.
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